
Part Number: 169990-1CD
Revision: 1

PC PATTERN GENERATION 
TOOL MANUAL
FOR DX AND MLX CONTROLLERS

Upon receipt of the product and prior to initial operation, read these instructions thoroughly, and retain 
for future reference.

MOTOMAN INSTRUCTIONS

PALLETSOLVER PC SETUP AND OPERATION MANUAL
MOTOMAN INSTRUCTIONS
CONTROLLER INSTRUCTIONS
OPERATOR’S MANUAL (for each purpose)
MAINTENANCE MANUAL 

The operator’s manual above corresponds to specific usage. 
Be sure to use the appropriate manual.
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Copyright © 2015, Yaskawa America, Inc. All Rights Reserved.

TERMS OF USE

This software is the offline portion of a global offline/online 
palletizing solution. Any physical limit provided by this application is 
based on user inputs. For security purposes, any limit provided by 
this software should always be validated before be used on an 
automated system.

Users should carefully read this manual and understand the 
limitations of the product before using it. 

AXIUM or Yaskawa America Inc. is not responsible for incidents 
arising from usage of this software.
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MANDATORY

• This instruction manual is intended to explain mainly the software 
part of the PC Pattern Gerneration Tool for the PalletSolver 
Solution. It describes details necessary for the operating 
instructions. Be sure to read and understand this instruction manual 
thoroughly before installing and operating the PalletSolver PC 
Pattern Gerneration Tool.

• General items related to safety are listed in the Chapter 1: Safety of 
the controller instructions. To ensure correct and safe operation, 
carefully read the controller instructions before reading this manual.

CAUTION

• The drawings and figures in this manual are representative 
examples and differences may exist between them and the 
delivered product.

• YASKAWA may modify this product without notice when necessary 
due to product improvements, modifications, or changes in 
specifications.
If such modification is made, the manual number will also be 
revised.

• If your copy of the manual is damaged or lost, contact a YASKAWA 
representative to order a new copy. The representatives are listed 
on the back cover. Be sure to tell the representative the manual 
number listed on the front cover.

• YASKAWA is not responsible for incidents arising from unauthorized 
modification of its products. Unauthorized modification voids your 
product’s warranty.
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Notes for Safe Operation
Read this manual carefully before installation and operation of the PC 
Pattern Gerneration Tool. 

In this manual, the Notes for Safe Operation are classified as 
“WARNING”, “CAUTION”, “MANDATORY”, or “PROHIBITED”.

Even items described as “CAUTION” may result in a serious accident in 
some situations.

At any rate, be sure to follow these important items.

Registered Trademark
In this manual, names of companies, corporations, or products are 
trademarks, registered trademarks, or bland names for each company or 
corporation. The indications of (R) and TM are omitted.

DANGER
Indicates an imminent hazardous 
situation which, if not avoided, could 
result in death or serious injury to 
personnel

WARNING
Indicates a potentially hazardous 
situation which, if not avoided, could 
result in death or serious injury to 
personnel.

CAUTION
Indicates a potentially hazardous 
situation which, if not avoided, could 
result in minor or moderate injury to 
personnel and damage to equipment. 
It may also be used to alert against 
unsafe practices.

MANDATORY
Always be sure to follow explicitly the 
items listed under this heading.

PROHIBITED
Must never be performed.

NOTE
To ensure safe and efficient operation at all times, be sure 
to follow all instructions, even if not designated as 
“DANGER”, “WARNING” and “CAUTION”. 
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1 Introduction

1.1 Software Overview

The PalletSolver software is used to generate pallet build information 
based on defined product, gripper and cell configuration. This build pattern 
will be specific to the cell chosen and specific to the infeed and pallet 
station chosen during the build process.

Pattern generation process flow is depicted in Fig.1-1 "Pattern Generation 
Process":

Fig. 1-1: Pattern Generation Process

The user first defines the packages (boxes, pallets and slipsheets), the 
grippers and the cells in the database. User then creates a pattern using 
the defined components. Once all the pattern creation steps are done and 
the pallet build is valid, the user generates the XML pattern files that will 
be exported to the palletizing cell.
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2 User Interface Overview

2.1 Main Screen

The main screen offers an overview of the software. It is composed of 
multiple tools that help the user to edit the project in order to generate 
pattern files. The application menus and general toolbar are located at the 
top of the screen. To the left, you will find the project explorer that shows 
the project elements. The interface is mainly filled by the editor that will 
allow the user to edit the database and the defined patterns.

Fig. 2-1: Main Screen

2.1.1 Menus

2.1.1.1 Files Menu

By clicking on the File menu, you can create a new project, open an 
existing project, save the project, close the current project or exit the 
application. Saving the project requires a hardware key license that has to 
be inserted in the computer USB port.

If this is the first time that PalletSolver is being used, you can start a new 
project by selecting the File menu, then New, then New Project (or simply 
press Ctrl+N).

Fig. 2-2: New Project Dialog

Project 
Explorer

Editor

Menu/Toolbar 
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When the New Project dialog appears, give the project a name by filling 
out the File name field. Select a directory to save the project and click 
Save. 

2.1.1.2 Edit Menu

The Edit menu is visible when a project is opened. It is used to copy, paste 
and select items in the project.

2.1.1.3 View Menu

The View menu is used to show the application project explorer. 

2.1.1.4 Project Menu

The Project menu is visible when a project is opened. It is used to add, 
import and export items to the opened project. Also, once the project is 
opened, you will be able to import and export an XML database.

To import an XML database to the current project, select the Project menu 
 Import  XML Database. Select the database XML file from the right 
directory. The Import Database dialog is displayed.

Fig. 2-3: Import Database Dialog

In the Tables to Import section, the user can select the database items to 
import. If Import Only Selected is checked, only selected elements will be 
exported. To select multiple items, hold [Ctrl] key and click on the row. 
Selecting all rows can be done with [Ctrl+A]. 

The Existing Data drop down offers the option to not add ID imported data 
that already exists or to replace/update if the imported data already exist 
in the opened project. Click Import to complete the database import. 
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To export the XML database of the current project, select the Project menu 
 Export  XML Database. Select the database XML file from the right 
directory. The Export Database dialog is displayed:

Fig. 2-4: Export Database Dialog

In the Tables to Export section, the user can select the database items to 
export. If Export Only Selected is checked, only selected elements will be 
exported. To select multiple items, hold Ctrl key and click on the row. 
Selecting all rows can be done with Ctrl+A. Click Export to complete the 
database export.

2.1.1.5 Tool Menu

The Tools menu is used to edit the general application settings. Select the 
Tools menu  Options. The Options dialog is displayed. 

 Pattern Output
Select the Application branch, then Patterns Output.

Fig. 2-5: Pattern Files Output Directory Option
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The Pattern Files Output Directory will be the base directory where the 
pattern files are generated. It is recommended that you create a new 
directory for the generated pattern and that you identify the project in the 
name of the directory. You can copy/paste the path of the directory in the 
field or click the browsing button, to the right, to open the Browse dialog:

Fig. 2-6: Browse For Folder Dialog

Select the output directory and click OK.

If the Output build pattern 3D view file checkbox is checked, the built pallet 
3D view image (png) will be generated with the output pattern file.

If the Output layer style 2D view files checkbox is checked, the place 
sequencing images (png) for each layer style will be generated with the 
output pattern file.

 Units
In the Options dialog, select the Application branch, then Units.

Fig. 2-7: Units Option

You can choose metric or imperial units for the Dimensions and the 
Weight values. Note that if a project is opened, you must close and reopen 
the project to apply the units' changes.
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 Data Type
In the next step, select the Database branch, then Data Types.

Fig. 2-8: Data Types

This option allows changing the Product ID and the Pattern ID types to a 
Numeric value between 0 and 32767 or an Alphanumeric 16 character 
string. Note that the Alphanumeric type may not be supported on all 
systems.

 Pallet Build Editor
Select the Pattern Editor branch, then Place Build Editor.

You can here define the pallet build maximum height and maximum 
weight that can be applied to all the patterns when building the 
pallet.

Fig. 2-9: Pallet Max Build Height and Weight Option
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2.1.1.6 Help Menu

In the Help menu, select User Guide to open the application 
documentation in PDF format. Finally, the About PalletSolver displays the 
application information as well as the hardware key information (key ID 
and type) if it is inserted.

Fig. 2-10: About PalletSolver Dialog

2.1.2 Project Explorer

The project explorer displays the project elements in different branches so 
that you can browse them easily.

Double clicking the node will open the corresponding element editor in the 
Editor pane.

Fig. 2-11: Project Explorer

The project explorer can be docked by drag and dropping from the Project 
Explorer label. It can also be closed with the  button and opened through 
the View menu.
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3 Defining Packages

3.1 Overview

The packages are defined by the user and are then used when defining 
the cells and the patterns. After clicking on the Packages node in the 
project explorer, the packages editor is opened:

Fig. 3-1: Packages Editor

The toolbar Filter option is used to filter the packages by type: Boxes, 
Pallets and Slipsheets.

3.2 Adding Packages

You can add a new package from:

• Menu: Project  Add New  Package  Package Type

• Toolbar: Add New   Package  Package Type

• Project Explorer: Right-click on Packages  Add  Package Type

The Package Type is Box, Pallet or Slipsheet.
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3.3 Importing Packages

You can import Packages from Excel or CSV (comma separated values) 
files.

3.3.1 Excel

The Excel packages data must be in the first worksheet, starting at the first 
column and ending at the 10th column like in Table 3-2 "Excel Packages 
Format". 

Fig. 3-2: Excel Packages Format

(1) Select the Project menu, then Import  Packages  Excel

(2) Select the file in the Open Dialog

(3) Click Import to import the data.

NOTE
A numeric value must define the package type: 1 for box, 
2 for pallet and 3 for slipsheet. Also, the columns order must 
be respected and the row describing the columns titles is 
optional. 
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3.3.2 CSV

The CSV packages data must be in the following format: Package ID, 
Type, Name, Length, Width, Height, Weight, Acceleration, Velocity, Label 
Position

(1) Select the Project menu, then Import  Packages  CSV

(2) Select the file in the Open Dialog

(3) Click Import to import the data.

Fig. 3-3: Excel/CSV Packages Import

NOTE

The columns order must be respected for the package type, 
a numeric value must define the package type: 1 for box, 
2 for pallet, and 3 for slipsheet. Also, the columns order 
must be respected and that the row describing the columns 
titles is optional.

NOTE

For both formats, all invalid rows will be ignored. In the 
Tables to Import section of the Import Packages dialog, you 
can select the database items to import. If Import Only 
Selected is checked, only selected elements will be 
imported, otherwise all the data will be imported. To select 
multiple items, hold Ctrl and click on the row. Selecting all 
rows can be done with Ctrl+A. The Existing Data drop down 
offers the option to not add ID imported data that already 
exists or to replace/update if the imported data already exist 
in the opened project. Click Import to complete the 
packages import.
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3.4 Editing Packages

You can edit the packages by entering values in the grid. Cell selecting 
can be done with the mouse click or with the keyboard arrows. When a 
cell is selected, you can enter the value and press Enter to confirm the 
change or Escape to cancel it. 

The different packages properties formats are presented below:

Table 3-1: Packages Data Format

For Boxes, you can select the label position with the Label Position 
Selection tool:

Fig. 3-4: Label Position Selection Tool

If one of the 4 labels is clicked, it will be displayed in red which means that 
the box has a label in that selected side. Clicking on a selected label will 
deselect it. The box label position will be calculated as a bit wise value 
from the selected labels sides.

3.5 Deleting Packages

You can delete a package by selecting a row in the Package Editor and 
pressing the Delete key.

Property Type Min Max

Product ID Integer (Numeric) 1 32767

String 
(Alphanumeric)

1 char 16 char

Name String 1 char 50 char

Length (mm) Decimal >0 2000

Width (mm) Decimal >0 2000

Height (mm) Decimal >0 2000

Weight (kg) Decimal >0 100

Acceleration (%) Decimal 20 100

Velocity (%) Decimal 0 100

NOTE
Package height equal to 0 is allowed for pallets. This can be 
used to define a palletizing area in the case where there is 
no physical pallet.

NOTE When deleting a package, any existing patterns that use 
that package will become invalid.
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4 Defining Grippers

4.1 Overview

The grippers are defined by the user and are then used in the patterns. 
After clicking on the Grippers node in the project explorer, the grippers 
editor is opened as followed:

Fig. 4-1: Grippers Editor

At the top of the grippers editor, you will find a toolbar that contains a filter 
drop down to filter the grippers by type. It also contains some useful 
buttons to add elements that will be viewed later. On the left, you can see 
the defined grippers' list. In the Properties pane, you can edit the selected 
gripper properties. In the Virtual Grippers pane, you can define the virtual 
grippers that will be used in the place sequencing when a pattern is build. 
On the right, the Grip Areas and Sensors displays a bottom view of the 
gripper where the physical grip areas and sensors can be defined. At the 
bottom, a help image is displayed to explain the different grippers' physical 
properties.

When creating a new gripper, the user should add a gripper of the proper 
type. From the gripper CAD drawing, the user defines the physical gripper 
properties, grip areas and sensor areas in relation with the tool center 
point (TCP). It is important that the TCP defined in this application be the 
same as the one on the actual system. The user must then define one or 
more virtual grippers. The virtual gripper allows combining one or more 
grip areas and sensors into logical zones that facilitate the handling of 
packages.

Grippers
List

Gripper
Property

Virtual 
Grippers
List

Help 
Image

Physical 
Gripper
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4.2 Adding Grippers

You can add a new package from:

• Menu: Project  Add New  Gripper  Gripper Type

• Toolbar: Add New   Gripper  Gripper Type

• Project Explorer: Right-click on Grippers  Add  Gripper Type

The Gripper Types are Vacuum, Clamp Fixed Edge, Clamp Moving Edge, 
Fixed Fork, Retractable Fork, Variable Stroke Fork or Bag Gripper. 

When the New Gripper dialog appears, you can enter the Gripper ID and 
the Gripper Name. Click OK to create the new gripper.

Fig. 4-2: New Gripper Dialog

NOTE
The Gripper ID is used to validate the correspondence 
between the gripper defined in this application and the one 
defined on the actual system.
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4.3 Editing Grippers

4.3.1 Vacuum Grippers

You can edit the following vacuum gripper properties:

Table 4-1: Vacuum Gripper Properties

The gripper dimension properties are used to calculate potential 
interference between the gripper and various stations. Therefore the 
dimension defined should be the overall dimensions of the gripper 
including any protrusions that may cause interference. TCP offsets values 
(-X, +X, -Y, +Y) should be positive.

The help image explains the physical properties of the vacuum gripper:

Fig. 4-3: Vacuum Gripper Help Image

You can then define the physical gripper by adding grip areas and 
sensors.

Property Type Min Max

Name String 1 char 50 char

-X Interference (mm) Decimal >=0 2000

+X Interference (mm) Decimal >=0 2000

-Y Interference (mm) Decimal >=0 2000

+Y Interference (mm) Decimal >=0 2000

NOTE
The grip area IDs and sensors IDs are used on the real 
system to map I/O signals that interact with each zone. It is 
therefore important to assign the proper IDs with the correct 
physical and logical locations.
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To add a grip area, right click on the physical gripper then select Add Grip 
Area in the context menu. It can also be done with the Add Grip Area 
button  in the grippers' toolbar.

Fig. 4-4: Add Grip Area Menu

A New Grip Area is Created

Fig. 4-5: :New Grip Area

The Grip Area can be moved to any position on the gripper. You can 
simply select the Grip Area and whether drag it with the mouse or move it 
using the arrow keys.

Fig. 4-6: New Gripper Moved
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Right click on the Grip Area to display its context menu. You will then be 
able to delete the Grip Area, set its position and resize it.

To add a sensor, right click on the physical gripper then select Add Sensor. 
It can also be done with the  Add Sensor button in the grippers' toolbar.

Fig. 4-7: Add Sensor Menu

A new sensor is created:

Fig. 4-8: New Sensor

The sensor can be moved to any position on the gripper. You can simply 
select the sensor and whether drag it with the mouse or using the arrow 
keys.

Fig. 4-9: New Sensor Moved
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You can define up to 32 grip areas and 32 sensors for each gripper.

Fig. 4-10: Multiple Grip Areas and Sensors

Once the physical gripper is defined, you can define up to eight virtual 
grippers for the selected gripper. To add a new virtual gripper, right click on 
the Virtual Grippers pane or click on the Add virtual Gripper Button  in 
the toolbar. The Add Virtual Gripper dialog is displayed:

Fig. 4-11: Add Virtual Gripper Dialog

You must choose the number of zones (maximum 8) of the virtual gripper 
and then click OK. A new virtual gripper is added in the Virtual Grippers 
pane. The virtual gripper can be renamed or deleted through its context 
menu (by right clicking on the virtual gripper node). Deleting all the defined 
virtual grippers can be done through the context menu by right clicking 
after the last node in the Virtual Gripper pane. 

To associate the physical gripper grip areas and sensors with the virtual 
grippers' zones, you can right click on the Grip Areas or the Sensors 
nodes.

First, right click on the Grip Areas node, then select Add Grip Area. In the 
Add Grip Area dialog, you can choose to define Grip Area ID and click OK.

Fig. 4-12: Add Grip Area Menu and Dialog
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Second, right click on the Sensors node, then select Add Sensor. In the 
Add Sensor dialog, you can choose to define Sensor ID and click OK.

Fig. 4-13: Add Sensor Menu and Dialog

You can add different grip areas to the same zone (same for sensors). 

Fig. 4-14: Grip Areas

You can delete the selected grip area or the sensor by right clicking on it 
and then clicking on Delete from the context menu. It is also possible to 
clear all the grip areas of the zone by right-clicking on the Grip Areas node 
and then clicking on Clear Grip Areas from the context menu (same for 
sensors).

4.3.2 Fixed Edge Clamp Grippers

The Fixed edge clamp gripper contains the same properties as the 
vacuum gripper. In addition, you can edit the following clamp specific 
properties:

Table 4-2: Clamp Fixed Edge Gripper Properties

NOTE A grip area or a sensor cannot be present in more than one 
zone for the same virtual gripper.

Property Type Min Max

Clamp #1 Thickness (mm) Decimal >0 2000

Paddle #1 Position (mm) Decimal -2000 2000

Paddle #2 Stroke (mm) Decimal >0 2000

Paddle #2 Thickness (mm) Decimal >0 2000

Paddle #2 Position (mm) Decimal -2000 2000
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The help image explains the physical properties of the fixed edge clamp 
gripper.

Fig. 4-15: Clamp Fixed Edge Gripper Help Image

The procedure to add, edit and delete virtual grippers, grip areas and 
sensors is the same as the vacuum gripper. Each added grip area 
contains 2 clamps.

4.3.3 Moving Edge Clamp Grippers

The Moving edge clamp gripper contains the same properties as the fixed 
edge clamp gripper. In addition, you can edit the Clamp #1 Stroke 
properties:

Table 4-3: Clamp Moving Edge Gripper Properties

The help image explains the physical properties of the moving edge clamp 
gripper:

Fig. 4-16: Clamp Moving Edge Gripper Help Image

Property Type Min Max

Clamp #1 Stroke (mm) Decimal >0 2000

Clamp #1 Thickness (mm) Decimal >0 2000

Paddle #1 Position (mm) Decimal -2000 2000

Paddle #2 Stroke (mm) Decimal >0 2000

Paddle #2 Thickness (mm) Decimal >0 2000

Paddle #2 Position (mm) Decimal -2000 2000
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The procedure to add, edit and delete virtual grippers, grip areas and 
sensors is the same as the vacuum gripper. Each added grip area 
contains two clamps.

Fig. 4-17: Clamp Fixed Edge Grip Areas Image

4.3.4 Fixed Fork Grippers

The fixed fork gripper contains the same properties as the vacuum 
gripper. In addition, you can edit the following specific properties:

Table 4-4: Fixed Fork Gripper Properties

Fig. 4-18: Fixed Fork Gripper Help Image

Property Type Min Max

Wall Position (mm) Decimal -2000 2000

Fork Length (mm) Decimal >0 2000

Fork Pitch (mm) Decimal >0 2000

Fork Width (mm) Decimal >0 2000

Box Max Height (mm) Decimal >0 2000

Box Min Height (mm) Decimal >0 2000

27 of 79



4     Defining Grippers
4.3  Editing Grippers

4-10

169990-1CD

169990-1CD

PC Pattern Gerneration 
Tool

The procedure to add, edit and delete virtual grippers, grip areas and 
sensors is the same as the vacuum gripper. The grip areas can be moved 
only along the X-axis.

Fig. 4-19: Fixed Fork Gripper Editor

4.3.5 Retractable Fork Grippers

The retractable fork gripper contains the same properties as the fixed fork 
gripper. In addition you can edit the following specific properties:

Fig. 4-20: Retractable Fork Gripper Help Image

The procedure to add, edit and delete virtual grippers, grip areas and 
sensors is the same as the fixed fork gripper.

Property Type Min Max

Fork Max Stroke (mm) Decimal >0 2000
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4.3.6 Variable Stroke Fork Grippers

The variable stroke fork gripper contains the same properties as the fixed 
fork gripper. In addition, you can edit the following specific properties

Table 4-5: Variable Stroke Fork Gripper Properties

Fig. 4-21: Variable Stroke Fork Gripper 

The procedure to add, edit and delete virtual grippers, grip areas and 
sensors is the same as the fixed fork gripper. The grips areas can be 
moved only along the X axis.

Property Type Min Max

Fork Min Stroke (mm) Decimal >0 2000

Fork Max Stroke (mm) Decimal >0 2000
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4.3.7 Bag Grippers

The bag gripper is similar to a combination of the dual clamp gripper and 
the fork gripper. To the fixed fork gripper, parameters for a second fork 
(Wall 2 Position and Fork 2 Length) are added. It is considered that the 
bags will be drop from a height that allows the fork to clear other bags on 
the same layer, so fork is not be considered in interference check with 
other bags. So in addition to the Fixed Fork Gripper property, for this 
gripper type, you can edit the following specific properties:

Table 4-6: Variable Bag Gripper Properties

Fig. 4-22: Bag Gripper Help Image

The procedure to add, edit and delete virtual grippers, grip areas and 
sensors is the same as the fixed fork gripper. The grips areas can be 
moved only along the X axis.

4.3.8 Gripper Pick Validation

The pick validation parameters are common to all gripper types. For each 
gripper, you can edit the following specific properties:

Table 4-7: Variable Fork Gripper Properties

The PackageCenterControlX and PackageCenterControlY parameters 
are percentages of box size in their corresponding axis.

GripZoneFullCoverage allows user to specify if a grip zone needs full 
coverage to be valid.

GripAreaSinglePackageCoverage allows user to specify if a grip area can 
overlap two packages or needs to overlap only with one package.

Please see Appendix A.1 "Gripper Pick Validation Parameters" for 
information about pick validation.

Property Type Min Max

Wall 2 Position (mm) Decimal -2000 2000

Fork 2 Length (mm) Decimal >0 2000

Property Type Min Max

Package Center Control X Decimal 0 100

Package Center Control Y Decimal 0 100

GripZoneFullCoverage Boolean false true

GripAreaSinglePackageCoverage Boolean false true
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4.4 Deleting Grippers

You can delete a gripper by selecting the gripper in the grippers list and 
pressing the Delete key. 

NOTE
If a gripper is deleted, all its grip areas, its sensors, and its 
virtual grippers will be deleted. Furthermore by deleting a 
gripper, any existing patterns that use that gripper will 
become invalid.
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5 Defining Cells

The cells are defined by the user and are then used in the patterns.

5.1 Adding cells

The user can add a new cell from:

• Menu: Project  Add New  Cell

• Toolbar: Add New   Cell

• Project Explorer: Right-click on Cells  Add Cell

The New Cell dialog is displayed:

Fig. 5-1: New Cell Dialog

You must enter the following information:

• Cell ID: Numeric

• Cell Name: string (maximum 50 characters)

• Product Gripper: select from the previously defined grippers

• Number of build stations: max 8. This will also be the number of 
infeed stations

• Number of pallet dispensers: max 2. This property is disabled if no 
pallet is defined in the Packages.

• Number of the slipsheet dispensers: max 2. This property is disabled 
if no slipsheet is defined in the Packages.

Click OK to create the cell. The cell is now added to the Cells node in the 
project explorer.
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5.2 Editing Cells

You can edit the previously defined cells.

5.2.1 Cell Components

Select the Cell Components tab.

Fig. 5-2: Cell Components Editor

You can edit:

• Cell Name

• Product Gripper
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5.2.2 Infeed Stations

Select the Infeed Stations tab.

Fig. 5-3: Infeed Station Editor

You can edit each infeed station properties.

Table 5-1: Infeed Station Properties

A right alignment will align the boxes on the side of the infeed station 
frame. For a center or left alignment the width of the conveyor is used to 
calculate the proper box position from the infeed frame. The interference 
limits define the boundary of the gripper when picking at the infeed station. 
The help image below the infeed stations grid gives a visual 
representation of the box alignment and the station interferences.

Property Type Min Max

Name String 1 char 50 char

Alignment Enum

Width (mm) Decimal >0 2000

-X Interference (mm) Decimal >0 3000

+X Interference (mm) Decimal >0 3000

-Y Interference (mm) Decimal >0 3000

+Y Interference (mm) Decimal >0 3000

Is forkable Boolean

Roll Diameter (mm) Decimal >0 1000

Roll Pitch Decimal >0 1000

First Roll Offset Decimal >0 1000

Forkable Side Enum >0
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5.2.3 Build Stations

Select the Build Stations tab.

Fig. 5-4: Build Station Editor

You can edit each build station properties.

Table 5-2: Build Station Properties

The interference limits define the boundary of the gripper when placing at 
the build station.The help image below the build stations grid gives a 
visual representation of the station orientation and interferences.

Property Type Min Max

Name String 1 char 50 char

Orientation Enum

-X Interference (mm) Decimal >0 3000

+X Interference (mm) Decimal >0 3000

-Y Interference (mm) Decimal >0 3000

+Y Interference (mm) Decimal >0 3000

35 of 79



5     Defining Cells
5.3  Deleting Cells

5-5

169990-1CD

169990-1CD

PC Pattern Gerneration 
Tool

5.2.4 Dispensing Stations

Select the Dispensing Stations tab

Fig. 5-5: Dispensing Stations Editor

You can edit each dispensing station properties:

• Name: string (max 50 characters)

• Pallet/Slipsheet Orientation: Length On X or Length On Y

• Pallet/Slipsheet ID: Select from the previously defined pallets/
slipsheets

5.3 Deleting Cells

A cell can be deleted if it does not have any patterns defined. To delete a 
cell, you can right click on the cell (under Cells in the Project Explorer) and 
then click on Delete. This action can also be done by selecting the cell and 
clicking on the Delete button  in the toolbar.

5.4 Modifying Cells

A cell’s station properties can be modified after patterns have been 
created but it may cause the existing patterns to become invalid.

NOTE
The Pallet/Slipsheet orientation defines the orientation 
relative to the dispenser frame and is used for calculating 
the pick information of the Pallet/Slipsheet. For the place, 
the calculation is based on the build station orientation.
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6 Defining Patterns

The user can create pattern using all the defined packages, grippers, cells 
in order to be able to build a valid pallet build and then generate the 
pattern file. In the project explorer, patterns are filtered by the cell that 
each pattern uses.

6.1 Adding Patterns

User can add a new pattern from:
• Menu: Project  Add New  Pattern

• Toolbar: Add New   Pattern

This will add the pattern to the first cell by default. If you want to add 
a pattern to a particular cell, right click on the cell node under 
Patterns then click on Add New Pattern.

6.2 Importing Patterns

You can also import CAPE CRF (Robotic Interface file) and TOPS 
exported pattern files from:

• Menu: Project  Import  Pattern  CAPE (CRF) or TOPS

• Project Explorer: right click on cell under Patterns node  Import 
Pattern  CAPE (CRF) or TOPS

You can select the CAPE or TOPS file in the Open dialog. The 
software will try then to match the file packages (box and pallet) 
name and dimensions with the database packages. If no match is 
found, you will be asked to add the new packages to the database:

Fig. 6-1: Import Packages Question
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When you click OK, the Import Packages box is displayed:

Fig. 6-2: Import Package Dialog

You can enter the new packages ID and click OK to complete the CAPE 
pattern import.

6.3 Editing Patterns

Pattern edition can be performed using the Pattern Editor. Using this 
editor, user will have to go through four (4) different steps before being 
able to generate a pattern file. At the end of each step, a validation 
process is performed and user is allowed to next step only if current step 
is valid. 

In first step, user basically chooses components from the project database 
like cell, pallet, slip-sheet, gripper, etc. On the second step, user will insert 
layers (called layer style) in the pattern either by choosing from a list of 
pre-defined layer styles or by inserting boxes in a build area. Several tools 
are available to facilitate layer style design. On third step, user will have to 
make placement sequencing on each layer made from preceding step. 
This step is where all the pick/placement coordinates are generated into 
the pattern. Finally, user will be able to build a pallet by selecting 
components like pallet, slipsheet or any layers previously defined. Once 
all wanted layers have been placed on the build area, user then will be 
able to generate the Pattern Output File. 

The next sections are describing each one of these 4 steps in details.
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6.4 Pattern Components

In this step, you define all the pattern components.

Fig. 6-3: Pattern Components Editor

You can define:

• Product: Select from the defined boxes list.

• Pattern ID: numeric value between 0 and 32767 or 16 characters 
alphanumeric string (see Data Type Options)

• Pattern Name: string (max 50 characters)

• Cell: Select from the defined cells list

• Infeed Station: Select from the defined infeed stations of the selected 
cell.

• Infeed Stopper offset : a value between -0 and 2000 (mm) to indicate 
the offset between the origin of the infeed and where the 1st product 
to pick is located along the X axis on the infeed.

• Build Station: Select from the defined build stations of the selected 
cell.

• Pallet: Select from the defined pallets list.

• Pallet Dispenser: Select from defined pallet dispensers of the 
selected cell and that are associated with selected pallet.

• Slipsheet 1: Select from the defined slipsheets list.

• Slipsheet Dispenser 1: Select from defined slipsheet dispensers of 
the selected cell and that are associated with selected slipsheet 1.
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• Slipsheet 2: if slipsheet 1 is defined, you can define a second 
slipsheet

• Slipsheet Dispenser 2: if slipsheet 1 is defined, select from defined 
slipsheet dispensers of the selected cell and that are associated with 
selected slipsheet 2.

• Consider Labels: select if the product labels are considered in the 
place sequencing step.

• Product Orientation on infeed station: 0, 90, 180 or 270 degrees

• Overhang/Underhang: a value between -2000 and 2000 (mm) to 
indicate the product overhang/underhang on the pallet.
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6.5 Layer Design Editor

At this step, every component (pallet, box, conveyor, gripper, etc.) to use 
in the pattern build process have been selected and validated. User is now 
ready to start creating some layers (currently referred as layer styles). 
This can be accomplished either by adding and moving boxes in a build 
area or importing some pre-defined layer styles. 

6.5.1 Overview

Fig. 6-4: Layer Design Editor

The editor is made of four (4) main components:

• The list of created/imported layer styles

• The build area where the selected layer style from the list is 
displayed

• The Toolbar which provides tools to work on the design

• The Pop-Up Menu which also provides tools to work on the design

From the layer style list control, user can add, remove or rename layer 
styles in the pattern. This is also where all the pre-defined layer styles are 
accessible.
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The main control of this editor is the build area. This is where the user can 
move boxes around to create or modify layer styles. The basics of this 
control is a 2D view with scale (zoom using mouse wheel) where user can 
select one or several items at the same by holding the CTRL key and 
either by clicking on items one at a time, or in making a selection rectangle 
by moving the mouse while holding the left button. Once some boxes are 
selected, a lot of commands are available to the user for manipulating 
them. Next section explains these commands in detail.

Fig. 6-5: Rectangle selection made by holding CTRL key and moving 
mouse left button down

42 of 79



6-7

169990-1CD

169990-1CD

PC Pattern Gerneration 
Tool

6     Defining Patterns
6.5  Layer Design Editor

6.5.2 Commands

Command Accessibility

Command Keyboard Toolbar Pop-up Menu

Add layer style

Remove layer style

Rename layer style Rename

Add Item Add Box (insert)

Delete Item Delete Box (del)

Rotate item Rotate Item(s) (r)

Move item Move Items

Set Item Position Set Item Position

Center on Pallet Center on Pallet (c)

Align items Top Align item(s) Top

Align Items Bottom
Align Item(s) 
Bottom

Align Items Left Align Item(s) Left

Align Items Right Align Item(s) Right

Flip in X-axis Flip in X-axis (x)

Flip in Y-axis Flip in Y-axis (y)

Set Labels Out Set Labels Out (O)

Set Item Gap X Set Item(s) Gap X

Set Item Gap Y Set Item(s) Gap Y
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 Add Layer Style
Execute to create a new empty layer style. User will then have to insert 
boxes into this newly created layer style.

 Remove Layer Style
Select a layer style in the list and you can execute remove. 

 Rename Layer Style
You can specify any name for your layer styles. Even if the program is 
allowing duplicate names, it is strongly suggested to keep these names 
unique so user will not see any duplicates that refers to the list of layer 
styles.

 Add Box
Use this command to insert a new box into the displayed layer style. When 
this command is executed using the mouse right-click and there is no box 
currently selected, the box is inserted at the right-click location. When this 
command is executed while some boxes are selected, program will insert 
the new box next to the segment formed by all selected items. It will first 
try at the right of the segment. If there is a collision, it will try to insert at the 
top, then on the left and then at the bottom. If there is a collision at the four 
locations, box will be inserted at the bottom. 

 Remove Box
User must select one or several boxes and can delete using this 
command.

 Rotate Item(s)
When executed, this command will make a 90 clockwise rotation on 
selected item. If there is more than one selected item, the same rotation is 
applied but on the segment formed by all selected items.

 Move Item(s)
Enter the distance to shift selected items. User can specify a distance in 
X-axis, in Y-axis or both at the same time.

 Set Item(s) position
Enter the new position of the selected item. If there is more than one 
selected items, the same translation is applied on all the other selected 
items.

 Center On Pallet
All selected items will shift at a position where the center of the segment 
formed by all selected items is at the center of the pallet.

 Align Items Top
All selected items will align their top with the topmost selected items. If 
command is executed from the right-click pop-up menu, all selected items 
will align their top with item that was clicked.

NOTE Only one layer style can be removed at a time.
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 Align Items Bottom
All selected items will align their bottom with the bottommost selected 
items. If command is executed from the right-click pop-up menu, all 
selected items will align their bottom with item that was clicked.

 Align Items Left
All selected items will align their left with the left most selected items. If 
command is executed from the right-click pop-up menu, all selected items 
will align their left with item that was clicked.

 Align Items Right
All selected items will align their right with the right most selected items. If 
command is executed from the right-click pop-up menu, all selected items 
will align their right with item that was clicked.

 Set Labels Out
All selected items will rotate so at least one of their labels will be on the 
outside of the pattern.

Fig. 6-6: Set Labels Out Command

 Flip in X-axis
This command will flip, in the X direction, the segment formed by all 
selected boxes. The movement is that boxes will be switching positions 
left-right and boxes that are at 0 or 180 degree orientation are rotating by 
180 degree. The next image is showing the transformation.

Fig. 6-7: Flip in X-axis Command
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 Flip in Y-axis
This command will flip, in the Y direction, the segment formed by all 
selected boxes. The movement is the boxes are switching positions 
top-bottom and boxes are at a 90 or 270 degree orientation that are 
rotating by 180 degree. The next image is showing the transformation.

Fig. 6-8: Flip in Y-axis Command

 Set Item(s) GapX
Use this command to set a gap in the x direction on selected boxes. This 
gap will be represented as a rectangle surrounding the box. This gap is 
applied when using the snap feature on the box (see snap feature).

Fig. 6-9: Items with a Gap in X-Axis

 Set Item(s) GapY
Use this command to set a gap in the y direction on selected boxes. This 
gap will be represented as a rectangle surrounding the box. This gap is 
applied when using the snap feature on the box (see snap feature).

Fig. 6-10: Items with a Gap in Y-Axis
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 Snap Feature
The snap is a feature that gives the user an easy way of placing boxes 
next to each other. As we have seen before, using the mouse, user is able 
to select boxes and then move the segment created by these boxes by 
holding the mouse left button and moving the cursor. The idea is to put a 
moving segment (or just one box) slightly in collision with some non-
moving boxes and upon releasing this segment, all moving boxes will 
adjust their position so the intersection of any moving boxes that is the 
nearest to any intersection of the non-moving boxes that are in collision 
with the moving segment will be aligned with that same intersection. There 
are three modes to the snap: Inactive, Active and Spread. This mode can 
be changed in the top toolbar. 

Fig. 6-11: Releasing items with snap in inactive mode 
We can see that boxes stayed where the user released them.

Fig. 6-12: Releasing items with snap in active mode
We see that boxes readjusted their position to be aligned with the 
non-moving segment

NOTE
User can have a moving segment spread while in Active 
mode by holding the “S” key while snapping boxes. The 
next images are showing examples of snap feature.
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Fig. 6-13: Releasing items with snap in Spread mode
Boxes readjusted their position to be aligned with the non-moving 
segment and they spread to match the length of the non-moving segment. 
User can obtain the same behavior in Active mode by holding the “S” key 
while releasing the boxes.

Fig. 6-14: Releasing items with a Gap in X-axis
We see that boxes readjusted their position to be aligned with the 
non-moving segment and the specified gap was applied.
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 Copy and Paste
A Layer Style can be copied/pasted from the popup contextual menu. 
User have to right-clicking on a Layer Style in the Layer Style list and then 
copy/paste.

Fig. 6-15: A Layer Style can be Copied/Pasted using the Commands from 
the Popup Menu

Once a layer style has been copied, user can use any command to modify 
it as wanted. 

As an example, user wants to create a mirror layer style. The way to do it 
is to copy and paste a layer style, then select all the boxes inside and use 
the Flip in X-axis or Flip in Y-axis command.

Boxes inside any layer style can also be copied and pasted into another 
layer style (or the same one). User have to select all the boxes that need 
to be copied and then copy/paste.

Fig. 6-16: Boxes in a layer style can be copied/pasted using the 
commands from the popup menu
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6.5.3 Pre-Defined Layer Styles

Fig. 6-17: Pre-Defined Layer Styles Dialog

This software comes with up to 250 pre-defined layer styles that user can 
easily import into their patterns. This list of pre-defined layer styles can be 
accessed by pressing on the button right below the layer 
styles list. From that list, user can select a layer style and hit  or 
simply double-click on a layer style to import it into the pattern.

Software will automatically adjust the imported layer styles to fit with the 
pattern box size. However, if an additional gap between boxes is needed, 
user can ask the software to add gap in x- or y-axis upon importing the 
layer styles by entering a gap value either in “Gap X” or “Gap Y” textbox. 

If labels are to be considered, user can ask to put the labels out upon 
importing by checking the “Make Labels out” check box.
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6.5.4 Layer Design Validation

This process is performed in two different situations:

• User is currently is the Layer Design step and click to go to Place 
Sequencing step;

• The “Generate Output File” command is executed;

For each layer style present in the pattern, this process is validating:

• Boxes outside or in collision with build station constraint;

• Boxes outside or in collision with pallet overhang;

• Boxes in collision with other boxes;

Fig. 6-18: User cannot access the place sequencing if a layer style is invalid.
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6.6 Place Sequencing Editor

At this step, every component (pallet, box, conveyor, gripper, etc.) to be 
used in the pattern build process has been selected and validated and 
user already has created or imported some layer styles. Now, user needs 
to specify the pick/placement sequence information for each one of the 
previously created/imported layer styles. 

6.6.1 Overview

The following figure is showing the components of the place sequencing. 
This editor is made of three main components. 

On the left, this is the infeed station display. Using this view, user can see 
and modify the pick portion of the sequencing. On the right, we can see 
the build station display from where user can specify the sequence to build 
a layer style. Finally at the top, there is the toolbar providing tools to 
select, modify and navigate through the sequencing of a layer style. 

Fig. 6-19: Place Sequencing Editor

On each box, there is some information displayed regarding the 
sequencing. User can read the cycle and placement number, the 
approach vector and the zone of the gripper used to place a particular 
box.

Fig. 6-20: Information displayed on a box
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6.6.2 Creating a Sequence

The sequence to build a whole Layer Style is divided into cycles. For each 
cycle, user must make and validate the pick, then make all needed 
placement(s) to drop all boxes present on the gripper. Only then user will 
be allowed to move on to the next cycle. This process is repeated until all 
boxes have been placed.

First step is to select a Layer Style from the Layer Styles Dropbox in the 
top toolbar. Once selected, you can see the skeleton from the Layers 
Design in the build station display.

Fig. 6-21: Select a Layer Style from the List

Create a new cycle by pressing on the Next button in the navigation pane. 
When you execute this command for the first cycle of a layer style, 
program is creating a new pick with the gripper configuration that can fit 
the most number of boxes. For all following cycles, the new pick will be the 
same as the previous cycle.

Fig. 6-22: Create a New Cycle
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Once a new cycle is created, on the infeed we can see the gripper filled 
with the maximum number of boxes it can hold. On the build station, we 
see the same gripper with the same amount of boxes. 

We can see that validation messages in both stations are saying: 
“Currently Picking”, meaning it is time to modify the pick (if needed) 
because once you have started making placements for a cycle, you can 
no longer modify its pick. At that stage, user is basically allowed to:

• Modify the position of the gripper on the infeed by dragging it using 
the mouse.

• Change the selected virtual gripper on the toolbar

• Add or remove box from the infeed station either by right-clicking on 
it (pop-up menu) or by using top toolbar shortcuts

• Select a pick from the pick selection table. This table is a list of all 
valid pick for all Virtual Grippers starting from the most efficient 
(more boxes, closest to origin, etc.) to the least efficient. 

Fig. 6-23: Toolbar for infeed station commands. 
User can select the current Virtual Gripper, add a box on infeed, remove a 
box from infeed or get the pick selection dialog

Fig. 6-24: Pick Selection Dialog
This is the list of all valid picks for all Virtual Grippers starting from the 
most efficient pick to the least efficient pick.

NOTE Both grippers are inserted so the bottom left corner of the 
first box is at the origin (0,0).
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So by using any of these means, user is able to create the wanted pick. It 
is important to note here that while the user is modifying the pick, it may 
become in a state where it is invalid (see Fig. 6.6.4 "Place Sequencing 
Validation" on page 6-24). In this case, the build station will be disabled 
and there will be a validation error message displayed on top of infeed 
station to help user fix the situation. User will be allowed to use the build 
station only when the pick will be in a valid state. 

After the new pick has been validated, user can now start dropping boxes 
using the build station to create placements. This can be achieved by 
clicking on any free box skeleton on the build area.

Fig. 6-25: Click on a Box Skeleton on the Build Station to Align the First 
Box on Gripper. Click Again to Move by One Box.

As user click on a skeleton, program will automatically align the first box 
on gripper with the clicked skeleton. If user click a 2nd time on the same 
skeleton (now covered by the first box on gripper), program will align the 
2nd box and so on for every box present on the gripper. When the last box 
is aligned on and user click again, there is two possibilities.

• If “Consider labels” option is selected, as boxes must match the full 
orientation (0,90,180 or 270 degree), the alignment will go straight 
back to the 1st box;

• “Consider labels” option is not selected, as boxes must only match 
the axis (0=180 and 90=270), gripper will rotate by 180 degree then 
the alignment will go back to the 1st box.

Program is showing some information about what can be done at the 
current position.

• A green box means that it is in a gripper zone ready to drop

• A blue box means that it was dropped in current displayed Cycle/
Placement

• A zone that can be dropped have a “Click to drop zone” flag right 
next to it

• A zone that was already dropped have a “Zone Dropped” flag right 
next to it

• An active zone is blue

• An inactive zone is transparent

• Gripper in collision is displayed in red

• Boxes in collision are displayed in red as well
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• For clamp grippers, clamps in collision are displayed in red as well

As an alignment is done on a skeleton, if user ca not see any green boxes, 
that means nothing can be done at that position. 

When user is ready to drop a zone, a single-click on the flag “Click to drop 
zone” will make the zone to drop its boxes. In a build cycle, once 
placement is started (first box has been dropped), user cannot modify the 
pick anymore so the infeed station will become disabled. The next figure is 
showing a cycle with the first box dropped in the first placement. 

Fig. 6-26: Click on a “Click to Drop Zone” to Release Boxes Held in that 
Zone

NOTE It is possible depending on configuration that a pattern 
cannot be finished.
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Every time a zone is released, if there are other zones ready to drop at 
current position, user will either have to drop some other boxes in the 
current placement, or click on another skeleton in order to find another 
valid drop position in which case, the editor will automatically generate a 
new placement since the drop position has changed since the last drop. 
Once at the new drop position, user can drop boxes in the new placement. 
Next figures are showing examples.

Fig. 6-27: Click on a “Click to drop zone” to release a 2nd box in the same 
placement. We can see that placement is still placement #1.

NOTE

Returning to the preceding drop position will not cancel the 
newly created placement. In other words, after dropping a 
box if you move the gripper to another drop location, a 
placement is automatically generated. User have to make 
sure to drop everything he wants to drop before moving to 
another drop location otherwise the cycle will have to be 
cancelled and restarted. 
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Fig. 6-28: Click on another skeleton to move the gripper to another drop 
position to generate a new placement. On top, we can see that placement 
is now placement #2.

Fig. 6-29: After generating the new placement by moving the gripper at a 
new location, user can click on the flag to drop a box in placement #2.

58 of 79



6-23

169990-1CD

169990-1CD

PC Pattern Gerneration 
Tool

6     Defining Patterns
6.6  Place Sequencing Editor

Every time the gripper is moved at a drop position, program is generating 
automatically the approach vector that should be used to make this drop. 
It is represented by red arrows on boxes.

Fig. 6-30: Program automatically generates the approach vector when 
gripper is at a drop position. We can see that the red arrow on the box to 
drop is pointing toward the box from the previous cycle.

However, if the automatically generated vector needs to be changed, it 
can be done pressing on the  (Approach Vector) button. This will show 
a dialog where user can change the vector for the currently displayed 
placement.

When there are no more boxes on gripper, the current cycle is finished. At 
this point, user can either move on to the next cycle if there are more 
boxes to place or review the sequence made so far using the in the 
navigation pane (last / next). User can also cancel the last cycle and redo 
it if needed.

This procedure will have to be repeated for every layer style present in the 
pattern. User will be allowed to the Pallet Build Editor only when all layer 
styles are done and valid.

6.6.3 Reviewing and Deleting Cycles

Navigation is made using the back and next buttons in the navigation 
pane. The next button actually has two behaviors, if current cycle is the 
last cycle, pressing this button will create a new cycle. Otherwise, it simply 
moves the current selection to the next cycle.

Since a cycle is dependent on all previous ones, a cycle in the middle of 
the sequence cannot be removed. Only the last cycle can be deleted by 
pressing on the  (Delete) button. 

All cycles can be deleted at once by pressing the  (Delete All) button.
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6.6.4 Place Sequencing Validation

This process is performed for two different situations:

• User is currently in the Place Sequencing step and clicks to go to the 
Pallet Build step;

• The “Generate Output File” command is executed.

For each layer style present in the pattern, this process validates all the 
build cycle (picks/placements) information.

6.6.4.1 Pick Validation

• Boxes are neither outside nor in collision with the infeed station 
constraint.

• Boxes are not in collision with other boxes.

• Gripper is neither outside nor in collision with the infeed station 
constraint.

• All boxes on the conveyor needs to be picked.

• A box cannot be shared by two gripper zones (there can be several 
boxes per zone).

Pick Validation tolerances must be respected (see Appendix A.1 "Gripper 
Pick Validation Parameters" for more information about pick validation)

 For Suction Cups Grippers Only:
• A zone picking boxes needs to be completely covered.

 For Clamp Grippers Only:
• Gripper clamps are in collision with boxes.

• Gripper clamps are neither outside nor in collision with infeed station 
constraint.

• Box too small for the course of clamps.

• Box too big for the course of clamps.

 For Fork Grippers Only:
• Gripper Forks are neither outside nor in collision with infeed station 

constraint.

• Gripper Forks can fit between Conveyor Rolls.

• Conveyor Rolls can fit between Gripper Forks.

• The box Height must be between the Box Min Height and Box Max 
Height parameters.

• A box needs to be over the forks at least by Y% of dimension along 
the conveyor.

• Box too small to be picked by the forks.

• Box too big to be picked by the forks.

• Gripper Orientation must match conveyor forkable side.

• Gripper X position is valid only when the gripper forks are not in 
collision with conveyor rolls.

 For Bag Grippers Only:
• Bag must intersect with forkset1 and forkset2
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6.6.4.2 Placement Validation

• Any box on the build station must match the position and orientation 
of a skeleton from the layer design step.

• Boxes are neither outside nor in collision with build station constraint.

• Boxes are not in collision with other boxes.

• Gripper is neither outside nor in collision with build station constraint.

 For Clamp Grippers Only:
• Gripper clamps are neither outside nor in collision with build station 

constraint.

• Gripper clamps are not in collision with boxes.

• An empty zone must not interfere with previously dropped boxes.

 For Fork Grippers Only:
• Gripper Forks are not in collision with build station constraint 

(see NOTE below…).

• Gripper Forks are not in collision with previously dropped boxes 
(see NOTE below…).

• An empty Forks zone must not interfere with previously dropped 
boxes (see NOTE below…).

• Gripper Forks can be retracted (fork stroke) without creating collision 
with boxes from previous cycle. The dimension of the constraint is 
fork stroke +25 mm starting from the sidewall position.

• Gripper Forks can be retracted (fork stroke) without creating collision 
with the build station constraint. The dimension of the constraint is 
fork stroke +25 mm starting from the sidewall position

 For Bag Grippers Only:
• "It is considered that the bags will be drop from a height that allows 

the fork to clear other bags on the same layer, so fork should not be 
considered in interference check with other bags..

NOTE
Since there is no information on the location of the forks 
after a drop (in or out), the interference check will consider 
forks to be taking the whole space of its stroke. 
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6.7 Pallet Build

In this last step, you can build a pallet using the defined layers styles:

Fig. 6-31: Pallet Build Editor

You can add a layer by double clicking on the layer style or by selecting 
the layer style in the list and clicking on the Add Layer Style button in 
the toolbar. A layer is always added at the end of the current list of layers.

As layers are added, the current build height and weight fields are 
updated.

If Define Max Build is checked, Max Build Height and the Max Build 
Weight of the pallet that were set in the Options menu will be enabled. 
Therefore, if you try to add a layer that make the pallet height or weight 
exceeding the maximum allowed, you will be notified that it cannot be 
added.

In the Layers List, you can select the layer to set the top layer in the 3D 
view of the pallet.

You can delete a layer from the layers list by selecting the row 
corresponding to the layer and then pressing the Delete key.

Layers
List

Pallet 3D View

Layers
Styles

Optional
Max Build
Height/Weight

Current Build
Height/Weight
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6.8 Generating Pattern Files

Once the built pattern is valid, you are able to generate the pattern file. 
This can be done in the Pallet Build editor by clicking on the Generate 
Pattern File button in the toolbar. It can also be done by right clicking on 
the pattern in the Project Explorer and then clicking on Generate Pattern 
File.

The pattern files and images will be generated in the Pattern File Output 
Directory in the Options menu. Each pattern is saved in the sub folder:

{ProjectName}\Cell {ID}\ 

• {ProjectName} - relates to the project name the pattern belongs to.

• {ID} - relates to the generated pattern cell ID. 

• The output pattern file name is composed of ProductID, 
PatternID, CellID, BuildStationID as follows:

ProductID,PatternID,CellID,StationID.xml

Once generated, the output file name is displayed next to the 
corresponding pattern name in the project explorer

6.9 Coping Patterns

To copy a whole pattern, right click on the selected pattern, then Copy To 
Cell:

Fig. 6-32: Select Destination Cell Dialog

Select the destination cell from the predefined cells list and click OK to 
complete the pattern copy. 

6.10 Deleting Patterns

A pattern can be deleted by right clicking on the pattern in the Project 
Explorer and then clicking on Delete. This action can also be done by 
selecting the pattern and clicking on the Delete button  in the general 
toolbar.

NOTE
If a pattern is copied to a different cell that uses a different 
gripper and where the stations definition is different, the 
pattern may become invalid. 
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Appendix A

A.1 Gripper Pick Validation Parameters

A.1.1 Gripper Validation Rules

1. A package must be covered by at least one grip area;

2. A package cannot overlap two grip zones;

3. Part of a package center zone must be covered by the grip zone;

4. Option to require that a grip zone be fully covered by one or more 
package;

5. Option to require that a grip area is fully cover by a single package;

The coverage is defined as the linear coverage along the X axis only. 

A.1.1.1 Package must be covered by at least one grip area

Case A-1: So the following case would be invalid because package 2 and 5 are not touching grip areas.
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A.1.1.2 Package cannot overlap two grip zones

Case A-2: The following case would be invalid because the two packages are overlapping grip zone 2.

A.1.1.3 Package Center Control

Specifies the allowable position of the center of a package from the grip 
zone.

• If the percentage is negative, then the center of the box can be 
outside the zone by the specified % of the box length. 

• If the percentage is positive, then the center of the box must be 
inside the zone by at least the specified % of the box length.

Case A-3: Package Center Control
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Case A-4: Is always valid:

Case A-5: Is always valid:
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Case A-6: Is valid if percentage set to -20%, but invalid is set at +20%.

Case A-7: Is always invalid:
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A.1.1.4 Grip Zone Coverage

Have an option to specify if a grip zone needs to be fully covered. Full 
coverage doesn’t necessarily need to be achieved by a single package. If 
enabled, it would invalidate the following case where only one grip area of 
grip zone 2 is covered.

Case A-8: Grip Zone Coverage
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A.1.1.5 Grip Area Coverage

Have an option to specify if a grip area needs to be fully covered by a 
single package. This would prevent the following case where a suction 
cup is between to package.

Case A-9: Grip Area Coverage
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A.2 VACUUM GRIPPER

A.2.1 Default Rules:

1. A package must be covered by at least one grip area;

2. A package cannot overlap two grip zones;

3. Package center must be +20% inside the grip zone;

4. Require that a grip zone be fully covered by one or more package;

5. Require that a grip area is fully cover by a single package;

Case A-10: Valid
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Case A-11: Valid

Case A-12: Valid
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Case A-13: Invalid because of rule #1: Packages are overlapping two zones.

Case A-14: Invalid because of rule #2: Zone 2 is not completely covered.

Note: Could be made valid by setting Grip Zone Coverage to 0%.
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Case A-15: Invalid because of rule #3: Grip area 1 is not completely covered by a box

Note: Could be made valid by setting Grip Area Coverage to 0%.

Case A-16: Invalid because of rule #4: Package 1 and 4 are not covered by 50%.

Note: Could be made valid by reducing the Grip Area Coverage below 50%.
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Case A-17: Invalid because of rule #5: Package 2 and 5 are not covered by a grip area.
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A.3 CLAMP AND FORK GRIPPER

A.3.1 Default Rules:

1. A package must be covered by at least one grip area;

2. A package cannot overlap two grip zones;

3. Package center must be +20% inside the grip zone;

4. Doesn't require that a grip zone be fully covered by one or more 
package;

5. Doesn't require that a grip area is fully cover by a single package;

Case A-18: Valid
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Case A-19: Valid

Case A-20: Valid
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Case A-21: Valid

Case A-22: Invalid because of rule #1: Packages are overlapping two zones.

Note: Could be made valid by combining grip area 1 and 2 into one zone as in case A-21.
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Case A-23: Invalid because of rule#2: Package on the right is not sufficiently gripped.
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